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Overview 

The Keithley Instruments Automated Characterization Suite (ACS) software supports component characterization 
testing of packaged parts and wafer-level testing using probers. ACS software can be installed on any computer, 
including Keithley Instruments Model 4200A-SCS Parameter Analyzer or Model 4200 Semiconductor 
Characterization System (4200-SCS) with a Microsoft® Windows® XP Professional Service Pack 3 (SP3), or 
Windows 7 x 86 (32 bit), Windows 7 x 64 (64 bit), Windows 10 x 86 (32 bit), or Windows 10 x 64 (64 bit) operating 
system. 

Updating ACS information 

NOTE If you have an older version of ACS software installed on your PC, Model 4200A, or Model 4200, and you 
are updating to the newest version of ACS, choose one of the following tasks to update your software. 
The following items also apply if you uninstall and reinstall the same version. 

Directly rename C:\ACS directory (recommended): 

1. Go to the C:\ACS directory and rename it C:\ACSx.x_old. 

2. Go to the C:\S4200 directory and rename it C:\S4200_old (NOTE: this only applies if you are NOT 
installing ACS on a Model 4200A or 4200). 

3. Install the new version of ACS. 

4. Once installed, restore user projects and libraries from ACSx.x_old, if needed. 

http://www.tek.com/keithley
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Overwrite earlier version of ACS when updating. 

1. Go to the C:\ACS directory, copy and paste the contents, then rename the ‘copy of ACS’ directory to 
ACSx.x_old. 

2. Go to the C:\S4200 directory and rename it C:\S4200_old (NOTE: this only applies if you are NOT 
installing ACS on a Model 4200A or 4200). 

3. Remove the C:\ACS\KATS\KATS_pref.ini file. (NOTE: this only applies if you have ACS v4.2 or earlier 
software installed and you are updating to a newer version). 

4. Install the new version of ACS.  
(If ACS detects the directory C:\ACS already exits, click Yes to continue the installation).  

Remove earlier version of ACS before updating. 

1. Go to the C:\ACS directory, copy and paste the contents, then rename the ‘copy of ACS’ directory to 
ACSx.x_old. 

2. Go to Windows® Start to remove ACS from your computer: Start > Program > ACS X.X -> Uninstall 
Automated Characterization Suite. 

3. Once uninstalled, delete the C:\ACS directory. 

4. Go to the C:\S4200 directory and rename it C:\S4200_old (NOTE: this only applies if you are NOT 
installing ACS on a Model 4200A or 4200). 

5. Install the new version of ACS. 

6. Once installed, restore user projects and libraries from ACSx.x_old, if needed. 

 

NOTE After installing a new version of ACS, you can still perform the following steps in order to launch an older 
version of ACS. 

1. Go to the C:\ACS directory and rename it C:\ACS_new. 

2. Go to the C:\ACSx.x_old directory and rename it C:\ACS. 

3. Open ACS software and the previous version will launch.  

4. In order to launch the newer version of ACS, rename C:\ACS to C:\ACSx.x_old and then rename 
C:\ACS_new to C:\ACS. 
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Supported models and test configurations 

NOTE Before you install ACS software on a computer, read and complete all of the pre-installation requirements 
listed in the Installation section of the Automated Characterization Suite (ACS) Reference Manual 
(document number ACS-901-01). This manual is provided in PDF format on your ACS Software CD-ROM 
(CD number ACS-950-01). 

The ACS software can be used with the following Keithley Instruments models in several different testing 
configurations: 

• Perform multi-group testing with Series 2600B System SourceMeter® instruments using ACS software installed 
on a personal computer or laptop. 

• Control Models 4200A-SCS or 4200-SCS hardware using ACS software installed on the Models 4200A-SCS or 
4200-SCS. 

• Perform combined group testing with Models 4200A-SCS or 4200-SCS, and Series 2600B instruments using 
the ACS software’s combined test-execution engine. 

• Control other external GPIB instruments using ACS software installed on a personal computer or laptop 
(external instruments are only controlled through a GPIB cable). 

NOTE When using the current release of ACS on a 4200-SCS, you should ensure that your 4200-SCS has KTEI 
V8.2SP2 or higher installed. 

 

NOTE If you install ACS v5.3 on S530 Parametric Test System platform, you must have revision 1.03h firmware 
or higher installed in the Model 707B Switch Matrix Mainframe. Refer to the Upgrading firmware section 
in the Model 707B Reference Manual (document number 707B-901-01). 

 

NOTE If you install ACS v5.3 on the S540 Parametric Test System platform, Keithley strongly recommends that 
the 2636 SMUs in your S540 are upgraded in order to use the latest firmware revision. Recommended 
versions are: 2.2.6 (or later) for 2636A SMUs and 3.2.2 (or later) for 2636B SMUs. These revisions 
incorporate several improvements that are important for proper operation of your S540. Refer to the 
documentation that came with your SMUs for upgrade instructions. 

 

NOTE ACS v5.2.1 requires a compatible version of S530-PM-200 protection modules in your S530 system. 
Compatible versions are S530-PM-200 with Waiver 8243 label or later, or S530-PM-200 with a “1.0” 
sticker. S530s that shipped from the factory with ACS v5.1, or later, already include compatible protection 
modules. S530 systems in the field that are being upgraded from a version earlier than ACS v5.1 will 
need to have their protection modules replaced with compatible versions. Contact Keithley service. 
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Installation 

ACS software comes with an installation option that allows you to generate a 30-day temporary license for quick 
installation of the software in the field. For complete ACS software installation requirements and instructions 
(including detailed licensing information), refer to the Installation section of the ACS Reference Manual. 

ACS Edition Version 5.3 

Overview  

Version 5.3 is the latest release of the ACS Edition software. 

Software compatibility 

You can use ACS software with Clarius software version 1.0, or later, that is included with the Model 4200A 
Parameter Analyzer without any modifications. 

When you start ACS on the 4200A-SCS that has Clarius software version 1.4 or higher (with Windows 10 operating 
system), a warning message may appear indicating that KXCI did not start successfully (see next figure).  

1. Select the Cancel button and the Program Compatibility Assistant will pop-up. 
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2. Select Run program to apply the compatibility settings. Note that this procedure is required one time. You will 
not have to run the compatibility assistant again. 

 

Note that you will have to manually fix the compatibility issue if the Compatibility Assistant does not open when you 
select Cancel (see step 1 above). 

To manually configure Compatibility mode, follow the next steps:  

1. Right-click the ACS icon and select properties.  

2. Open the Compatibility tab.  

3. Select the "Run this program in compatibility mode for" and using the drop-down arrow choose the appropriate 
operating system you have (for example Windows 7 or Windows 8) (see next figure). Note that this procedure is 
required one time. You will not have to accomplish this procedure again. 
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You can use ACS software with Keithley Interactive Test Environment (KITE) software version 8.2SP2, or later, 
without any modifications. 

For GPIB driver compatibility information, see the ACS Edition Reference Manual (document number ACS-901-01). 
This manual is provided in PDF format on the ACS Edition CD-ROM that is included with your shipment of ACS 
software. It is also available in the Help menu of ACS within the software. 

New Features 

Added the model Keithley HVM1212A high-voltage matrix to support 3kV HV test for the S540 system. (The 
Keithley high-voltage matrix is configured manually by using the ACS_Settings.ini file (located in the 
C:\ACS\KATS\ folder; then ACS will automatically scan the HV matrix and add it to the instrument tree.) 

Updated the ACS hardware configuration GUI to include the S540 system. 

Updated the S530 Diagnostic and Verification tool to include the S540 system. 

Added a S540 high voltage demo to the hardware configuration demo version, that includes ultra-high voltage, 
hybrid-high voltage, and ultra-high voltage with a DMM7510 and hybrid-high voltage with a DMM7510. 

Added the following ACS libraries in support of the S540 system: measCVcomp; HVCVLIB library; 
hvcv_genCompData. 

Added the following linear parametric test (LPT) commands in support of the S540 system: hvcv_intgcg; 
kihvmuxlpt; hvcvcomp; hvcv_measurecv; cvteststat. 

Updated the following ACS test commands in support of the S540 system: constantlpt; generaltest; 
generic_HVCV_test; ki26xxlpt; ki42xxlpt; Ki70xblpt; ki70xlpt. 

Added support for the following four CCS (constant current stress) and CVS (constant voltage stress) devices: 
4WR_8dev; Bipolar_8dev; LDMOS-16dev; Zener_8dev. 

Added a DC Compensation feature to test the SMU offset current and enable the relative (REL) function for the 
2600 ITM. 

Added step functionality for a time-dependent diametric breakdown (TDDB) module. 

Updated the Wentworth P300SRQ prober driver. 

Added MPI SENTIO prober driver, and lightON and lightOFF UAP files. 

Added global data support to the formulalib.py, and repaired the formula wrong name error message. 
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Critical fixes 
PR60730 Ongoing issues with ACS / Wentworth Probe Stations. 

PR57408 Formulator variables missing in limits page after adding formulator in STM. 

PR57323 ACS ITM delay is not correct in actual sweep. 

PR57211 PTM GUI disappears after switching the PTM module several times. 

PR57120 The VTLINGM formula result is not correct in ACS. 

PR56519 ACS ITM output voltage is wrong that is indicated by the VSweep in multiple SMUs. 
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ACS 5.3 Features and Supported SMUs 

ACS Feature 

Instruments     

Notes 2
4
0
0 

2
6
0
0 
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6
0
0
A 

2
6
0
0
B 

2
6
5
1
A 

2
6
5
7
A 

Virtual 
SMU 

42xx-
SMU 

42xx-
CVU 

2
3
7 

2
2
9
0 

7
5
1
0 

Automatic 
hardware 
scan and 
configuration 

√ √ √ √ √ √ X √ √ X X √ 

Model 237 and model 2290 power supply must be 
manually added as an external instrument. Virtual 
SMU must be manually combined in hardware 
configuration, supports combine two 2602A/B, two 
2612A/B, two 2636A/B or two 2651A SMUs. Support 
auto scan 2450/2460/2461 instruments in 2400 
series. 

ITM X √ √ √ √ √ √ √ X X X X 

The 2600 ITM supports Series 2600A/B trigger model 
and it supports both DC and pulse measurement. It 
also supports 265xA high-power SMUs in a safe 
configuration. Includes build-in sample test modules 
for variety of devices under ACS\Test Module 
Template\subsite directory, the name of the file ends 
with the following: _26xxB. The Model 4200 ITM only 
supports DC measurements. 

ACS-2600 
RTM X √ √ √ √ √ X X X X X X 

Includes HCI and NBTI, Fast-NBTI, Time dependent 
dielectric breakdown (TDDB_CVS), Voltage ramp 
(Vramp), Ramped current (Jramp), Electromigration 
(Iso_EM) and Poly_Heater modules. Includes VDS 
sample tests under ACS\Test Module 
Template\device\Vds Reliability directory. Only VDS 
Reliability sample tests can support 265xA. 

Generic 
HVCV PTM 
(GenericHVC
Vlib.py and 
CVITM.py) 

X √ √ √ √ √ X √ √ X X X 

Generic HVCV PTM test module with interactive style 
that allows you to use different series of SMUs in a 
safe connection to build a custom test. 3 kV bias tees 
and 200 V bias tees for the Model 4200 requires ACS 
installed on the 4200. No remote support. For CVITM, 
this requires KXCI and can be used from a remote 
computer, with ACS installed on the remote computer. 

Device 
specific 
HVCV PTM 

X √ √ √ √ √ X √ √ X X X 

Includes built-in device-specific HVCV test libraries 
and test modules for a variety of devices in the 
ACS\Test Module Template\Device directory, the 
name of the file ends with the following: _HVCV. 3 kV 
bias tees and 200 V bias tees for the Model 4200 
requires ACS installed on the 4200. No remote 
support. 

General 
Purpose PTM 
(Combined_T
est_ 
Mixed_SMUs.
py) 

√ √ √ √ √ √ X √ X √ X X 

Specific test module with interactive style that allows 
user to use different series of SMUs in a safe 
connection to build a custom test. Includes build-in 
sample test modules for variety of devices under 
ACS\Test Module Template\subsite directory, the 
name of the file ends with the following: _MixedSMUs. 
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Mixed SMU 
Pulse PTM 
(Mixed_SMUs
_ pulselib.py) 

√ √ √ √ √ √ √ √ X √ X X 

Mixed model of SMUs in pulse mode is mainly about 
the mixed use of model 2600, 2600A/B, 265xA, 24xx, 
237 and 42xx SMUs. Virtual SMU only supports 
combined two 2651A SMUs in PTM. 

Power supply 
library 
(PowerSuppl
yLib.py) 

X X √ √ X X X √ X X √ X 

The power supply PTM supports for Models 2290-5, 
2290E-5, 2290J-5, and 2290-10 power supplies. This 
module can support the following SMUs for 
measuring the current through the device: Models 
2611A/B 2612A/B, 2635A/B, 2636A/B, 4200-SMU, 
4210-SMU. 

PTM √ √ √ √ √ √ √ √ √ √ √ √ 

Can write scripts using the Script Editor tool to 
achieve maximum speed form TSP-enabled 
instruments. Supports LPT commands. Includes 
build-in test libraries for a variety of devices. 

STM X √ √ √ √ √ X X X X X X 

Can write scripts using the Script Editor tool to 
achieve maximum speed from TSP-enabled 
instruments. Supports LPT commands. Includes 
build-in test libraries for a variety of devices. 

CTM X X X X X X X √ X X X X 

There are two kinds of CTM: ACS Classic Style and 
Advanced Style (Support CTM List). Classic Style 
CTM only contains one test module, but the advanced 
style CTM contains many test modules. 

ACS also supports these instruments: 
• Keithley HVM1212A high-voltage matrix 
• Keithley 707/8A/B switches 
• Keithley Model 2010 DMM and 7510 DMM 
• Keithley 4200 CVU 
• Keithley Model 3700/3700A Switch/DMM 
• Agilent 4284 CV meter 

ACS supports these communication interfaces: 
• GPIB* (NI and Keithley cards only) 
• LAN* (PTMs and CTMs are not supported for this interface) 
• TSP-Link subordinates 
*GPIB and LAN cannot be used simultaneously 

 

Enhancements 

PR60330  Upgraded the Wentworth P300 SRQ and add MPI prober driver. 

PR58644  Added the ACS prober Z/D command skip flag settings to the ACS Reference manual. 

PR58133 Determined it is better to deselect "Automatic Contact Check" as the default value in Tools > 
Preferences page. 



Automated Characterization Suite (ACS) Release Notes 
 

10 PA-1008 Rev. L / November 2017 

 

Noncritical fixes 

PR60823 When the operator changes the stop value for the 4200 ITM, the step value changes automatically. 

PR60292 ACS graph information will not save correctly. 

PR59827 CVU Compensation View Data Button does not work from a remote system. 

PR58490 Removed references to Visual Studio from the ACS Documentation. 

PR58284 Step function doesn't work in ACS 5.2.1, General Test Lib. 

PR58152 ITM doesn't return to pulse mode of RPM. 

PR57870 ISO_EM doesn't work when SMU1 and SMU2 are not assigned. 

PR57703 Not able to enter and cannot see the value of the soft ramp when forcing current. 

PR57227 Added the PLC default settings to the ACS Reference Manual. 

PR56484 Data does not export to the CSV file when the pad name includes space (' '), GeneralTestLib. 

PR55706 Missing the formulator function POWB DEGRADATION GET_LISTINDEX GET_QBD_DOWN 
description in the ACS Reference Manual revision J, September 2015. 

Known issues 

PR-61401 When you choose to install the KUSB-488B GPIB card driver for ACS software, you must install the 
Keithley command-compatible driver. If you choose to install the NI command-compatible driver, 
then the instruments from Keithley may not appear in the scanned instruments during hardware 
configuration. 

PR-61402 After NI GPIB driver is installed, and while ACS software is installing, a dialog box may appear 
indicating that the installer was unable to automatically close all applications (NI server error). If this 
occurs, click the Ignore button to proceed. 
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ACS Edition Version 5.2.1 

Overview  

Version 5.2.1 is the latest release of the ACS Edition software. 

Software compatibility 

You can use ACS software with Keithley Interactive Test Environment (KITE) software version 8.2SP2 or later 
without any modifications.  

For GPIB driver compatibility information, see the ACS Edition Reference Manual (document number ACS-901-01). 
This manual is provided in PDF format on the ACS Edition CD-ROM that is included with your shipment of ACS 
software. It is also available in the Help menu of ACS within the software. 

New Features 

Added support capability for the Model DMM7510, to include hardware automatic scan, display of the hardware 
configuration GUI, and the configuration file. 

Added functionality to control the Model DMM7510 with LPT commands.  

Updated the S530 Diagnostic and System Verification tool for the Model DMM7510. 

Added the ability to support automatic scan for Models 2450 and 2460 instruments. You can select the instrument 
that you are using in the PTM GeneralTestLib. 

Added the ability to enable or disable with a refresh button in order to manually run a test and for real-time plotting 
during automation. 

Added a graph refresh button that supports custom STM and PTM testing. 

Added new Vds_ccs test modules. 

Added a delay factor functionality for the Model 2600 when using ITM trigger mode. 

Updated the PA200 and Cascade CM300 prober drivers. 

Added the Series 2600B instrument's new firmware version 3.2.2. 

Added the Series 2600A instrument's new firmware version 2.2.6. 
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Critical fixes 
PR56464 Binning Setting missing when restart ACS or reopen project. 

PR56462 Handling of error 5052, interlock engaged, system stabilizing. 

PR56309 2636A has random failures on S530 Prerequisites tests while measuring using ACS. 

PR56171 ACS start error when connected 2600 with mixed switch frame. 

PR55889 The timing settings disappear in CVITM after switch data page. 

PR55820 The 42SMU connection order not update in ITM after save project. 
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ACS 5.2.1 Features and Supported SMUs 

ACS Feature 

Instruments     

Notes 2
4
0
0 

2
6
0
0 

2
6
0
0
A 

2
6
0
0
B 

2
6
5
1
A 

2
6
5
7
A 

Virtual 
SMU 

42xx-
SMU 

42xx-
CVU 

2
3
7 

2
2
9
0 

7
5
1
0 

Automatic 
hardware 
scan and 
configuration 

√ √ √ √ √ √ X √ √ X X √ 

Model 237 and model 2290 power supply must be 
manually added as an external instrument. Virtual 
SMU must be manually combined in hardware 
configuration, supports combine two 2602A/B, two 
2612A/B, two 2636A/B or two 2651A SMUs. Support 
auto scan 2450/2460 instruments in 2400 series. 

ITM X √ √ √ √ √ √ √ X X X X 

The 2600 ITM supports Series 2600A/B trigger model 
and it supports both DC and pulse measurement. It 
also supports 265xA high-power SMUs in a safe 
configuration. Includes build-in sample test modules 
for variety of devices under ACS\Test Module 
Template\subsite directory, the name of the file ends 
with the following: _26xxB. The Model 4200 ITM only 
supports DC measurements. 

ACS-2600 
RTM X √ √ √ √ √ X X X X X X 

Includes HCI and NBTI, Fast-NBTI, Time dependent 
dielectric breakdown (TDDB_CVS), Voltage ramp 
(Vramp), Ramped current (Jramp), Electromigration 
(Iso_EM) and Poly_Heater modules. Includes VDS 
sample tests under ACS\Test Module 
Template\device\Vds Reliability directory. Only VDS 
Reliability sample tests can support 265xA. 

Generic 
HVCV PTM 
(GenericHVC
Vlib.py and 
CVITM.py) 

X √ √ √ √ √ X √ √ X X X 

Generic HVCV PTM test module with interactive style 
that allows you to use different series of SMUs in a 
safe connection to build a custom test. 3 kV bias tees 
and 200 V bias tees for the Model 4200 requires ACS 
installed on the 4200. No remote support. For CVITM, 
this requires KXCI and can be used from a remote 
computer, with ACS installed on the remote computer. 

Device 
specific 
HVCV PTM 

X √ √ √ √ √ X √ √ X X X 

Includes built-in device-specific HVCV test libraries 
and test modules for a variety of devices in the 
ACS\Test Module Template\Device directory, the 
name of the file ends with the following: _HVCV. 3 kV 
bias tees and 200 V bias tees for the Model 4200 
requires ACS installed on the 4200. No remote 
support. 

General 
Purpose PTM 
(Combined_T
est_ 
Mixed_SMUs.
py) 

√ √ √ √ √ √ X √ X √ X X 

Specific test module with interactive style that allows 
user to use different series of SMUs in a safe 
connection to build a custom test. Includes build-in 
sample test modules for variety of devices under 
ACS\Test Module Template\subsite directory, the 
name of the file ends with the following: _MixedSMUs. 
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Mixed SMU 
Pulse PTM 
(Mixed_SMUs
_ pulselib.py) 

√ √ √ √ √ √ √ √ X √ X X 

Mixed model of SMUs in pulse mode is mainly about 
the mixed use of model 2600, 2600A/B, 265xA, 24xx, 
237 and 42xx SMUs. Virtual SMU only supports 
combined two 2651A SMUs in PTM. 

Power supply 
library 
(PowerSuppl
yLib.py) 

X X √ √ X X X √ X X √ X 

The power supply PTM supports for Models 2290-5, 
2290E-5, 2290J-5, and 2290-10 power supplies. This 
module can support the following SMUs for 
measuring the current through the device: Models 
2611A/B 2612A/B, 2635A/B, 2636A/B, 4200-SMU, 
4210-SMU. 

PTM √ √ √ √ √ √ √ √ √ √ √ √ 

Can write scripts using the Script Editor tool to 
achieve maximum speed form TSP-enabled 
instruments. Supports LPT commands. Includes 
build-in test libraries for a variety of devices. 

STM X √ √ √ √ √ X X X X X X 

Can write scripts using the Script Editor tool to 
achieve maximum speed from TSP-enabled 
instruments. Supports LPT commands. Includes 
build-in test libraries for a variety of devices. 

CTM X X X X X X X √ X X X X 

There are two kinds of CTM: ACS Classic Style and 
Advanced Style (Support CTM List). Classic Style 
CTM only contains one test module, but the advanced 
style CTM contains many test modules. 

ACS also supports these instruments: 
• Keithley 707/8A/B switches 
• Keithley Model 2010 DMM and 7510 DMM 
• Keithley 4200 CVU 
• Keithley Model 3700/3700A Switch/DMM 
• Agilent 4284 CV meter 

ACS supports these communication interfaces: 
• GPIB* (NI and Keithley cards only) 
• LAN* (PTMs and CTMs are not supported for this interface) 
• TSP-Link subordinates 
*GPIB and LAN cannot be used simultaneously 

 

Enhancements 

PR56310 Having the countdown display in main GUI for stress test is appreciated. 

PR55721  Formulator issue, using ^2 doesn't work. 

PR55680  ACS UAP manual mode, test_begin and test_end should be effective with PTM. 
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Noncritical fixes 

PR56593 ACS *.tmp file output for PTM and STM. 

PR56355 Data was not saved into csv file except 1st pattern. 

PR56211 Dual sweep setting changes automatically on ACS 5.2, ITM (4200-SMU). 

PR56170 Add P8 prober setting in release notes to avoid ACS cannot control the prober movement. 

PR56165 Repaired the diagnostic tool 2-wire prerequisite test problem in ACS when the 2410 SMU is 
involved. 

PR55904 DIAGS: SMU Range tests do not test every SMU measure circuit, which can make it difficult to 
diagnose problems. 

PR55821 The 'Best fixed' force range should not display for 42ITM after change GND to SMU. 

PR55773 The formulator disappear but variables still display in4200ITM. 

PR55409 Add ITM GUI forcing functions, GND=force0V, Open=High Z enable in ACS manual. 

PR54693 ACS graph default color should not be random. 

PR51610 DIAGS: Decide on and implement changes to the "cal due date" text when running diag/system 
verify. 
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ACS Edition Version 5.2 

Overview  

Version 5.2 is the latest release of the ACS Edition software. 

Software compatibility 

You can use ACS software with Keithley Interactive Test Environment (KITE) software version 8.2SP2 or later with 
no special configuration requirements.  

For GPIB driver compatibility information, see the ACS Edition Reference Manual (document number ACS-901-01). 
This manual is provided in PDF format on the ACS Edition CD-ROM that is included with your shipment of ACS 
software. It is also available in the Help menu of ACS within the software. 

New Features 

Updated and added the newest S530 Diagnostic and System Verification tool. 

Added a 'Device Interface Setting’ GUI in the hardware configuration window (it includes the Models 8010 and 8020 
with bias tee settings). 

Updated the CVU compensation routine that is accessible through the Tools menu. 

Added a compensation demo data file; note that the name of the file begins with the following: factory_8010_. 

Added a Generic HVCV PTM test module with functions switching between C vs. V, C vs. t, and C vs. f; it works 
with both a 200 V bias tee and a 3 kV bias tee; it supports the Model 4200 SMUs, 26XX, and 2657A SMUs; you can 
access this test module through the import GenericHVCVlib.py file in a PTM. 

Added the following nine device-specific PTM libraries under the PTMLib folder: 

• Specific_IGBT.py 
• Specific_nMOSFET.py 
• Specific_npnBJT.py  
• Specific_npnPowerBJT.py 
• Specific_nPowerMOSFET.py 
• Specific_pMOSFET.py 
• Specific_pnpBJT.py 
• Specific_pnpPowerBJT.py  
• Specific_pPowerMOSFET.py 

Added following devices specific HVCV test libraries and test modules: 

ACS\Test Module Template\Device 

• IGBT: Cce, Cgc, Cge, Cies, Coes, Cres 
• npnBJT, pnpBJT, npnPowerBJT, pnpPowerBJT: Ccb, Cce, Ceb, Cibo, Cobo 
• nMOSFET, pMOSFET, npnMOSFET, pnpMOSFET: Cds, Cgd, Cgs, Ciss, Coss, Crss 
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Added a subsite loop page to subsite notebook that supports the stress/measure loop feature. 

Added DC_Stress_Measure_Loop and Pulse_Stress_Measure_Loop projects to the subsite loop. 

Added a subsite loop to send global data to the STM, if needed: 

"ACS_Stress_Time": 0 
"ACS_Stress_Duration": 0 
"ACS_Disable_Subsite_List":[] 
"ACS_Disable_DUT_List":[] 
"ACS_Disable_Test_List":[] 

Added a Pulse Stress measure loop sample for the PMU using xrc PTM (Pulse_Stress4Sample.py). 

Added support for combining two Model 2651A SMUs in Mixed_SMUs_pulselib.  

Enabled high voltage support in Vds_ramp and Vds_constant modules when using a Model 2657A SMU. 

Added ITM on and off sequence, and a sequence delay feature. This ITM is not functional on previous ITMs. 

Added support for combining Models 2602A/B, 2612A/B, and 2636B in series or parallel.  

Added the list V/list I for the Model 4200 ITM. 

Added the Series 2600B instrument's new firmware version 3.1.0. 

Removed the Generic 2-terminal GPI and Generic 4-terminal GPI instrument types from the available external 
hardware configuration.  

Added PTM support for Models 2290-5, 2290E-5, 2290J-5, and 2290-10 power supplies (PowerSupplyLib.py).  

Yang prober driver source code is built in. 

Added TEL T78S/80S and Cascade CM300 prober driver support. 



Automated Characterization Suite (ACS) Release Notes 
 

18 PA-1008 Rev. L / November 2017 

 

Critical fixes 
PR54592 Cannot auto scan 2010 DMM when ACS starting. 

PR54851 DIAGS VMTR test fails first time run. 

PR54577 KI42xxCVU module - hold time does not work in system mode. 

PR54576 KI42xxCVU module - sweeping V in negative direction causes errors in user mode. 

PR54551 ACS does not apply auto delay setting though auto delay is checked in preferences. 

PR54529 Support two 2651 combined in Mixed_SMUs_pulselib. 

PR54528 ACS 2420 sense setting is not supported in Combined_Test_Mixed_SMUs. 

PR53582 DIAGS: System Verify should verify each defined pin pair is shorted and issue an error if one or 
more are not. 

PR53581 DIAGS: Rethink pathway capacitance tests. 

PR53580 DIAGS: diags -k crashes when SMU1 is removed from configuration. 

PR53571 Trend file (xxx.csv) generated during system verifies is missing limits info. 

PR53569 DIAGS: Measuring on the 100pA range after the 200V range cause DA-related settling problems. 

PR53567 DIAGS: Change current measure range for high voltage test. 

PR53565 DIAGS: optional instrument tests pass when VMTR test has partial failure. 

PR51713 ACS Fast BTI AC Stress does not work. 

PR51608 ACS Formulator SS() does not work in specific condition. 

PR51607 ki20xxlpt avgX ignores KI_AVGMODE setting. 

PR50813 Change prober move command in prober driver to allow prober move large distance (>99 sites). 

PR48283 ACS does not clear all scripts at the startup. 

PR48269 ACS ITM Power Compliance is not correct. 
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ACS 5.2 Features and Supported SMUs 

ACS Feature 

Instruments 

Notes 
2400 2600 2600A 2600B 2651A 2657A Virtual 

SMU 
42xx- 
SMU 

42xx- 
CVU 

237 2290 

Automatic hardware 
scan and 
configuration 

√ √ √ √ √ √ X √ √ X X 

Model 237 and model 2290 power 
supply must be manually added 
as an external instrument. Virtual 
SMU must be manually combined 
in hardware configuration, 
supports combine two 2602A/B, 
two 2612A/B, two 2636A/B or two 
2651A SMUs. 

ITM X √ √ √ √ √ √ √ X X X 

The 2600 ITM supports Series 
2600A/B trigger model and it 
supports both DC and pulse 
measurement. It also supports 
265xA high-power SMUs in a safe 
configuration. Includes build-in 
sample test modules for variety of 
devices under ACS\Test Module 
Template\subsite directory, the 
name of the file ends with the 
following: _26xxB. The Model 
4200 ITM only supports DC 
measurements. 

ACS-2600 RTM X √ √ √ √ √ X X X X X 

Includes HCI and NBTI, 
Fast-NBTI, Time dependent 
dielectric breakdown 
(TDDB_CVS), Voltage ramp 
(Vramp), Ramped current 
(Jramp), Electromigration 
(Iso_EM) and Poly_Heater 
modules. Includes VDS sample 
tests under ACS\Test Module 
Template\device\Vds Reliability 
directory. Only VDS Reliability 
sample tests can support 265xA. 

Generic HVCV PTM 
(GenericHVCVlib.py 
and CVITM.py) 

X √ √ √ √ √ X √ √ X X 

Generic HVCV PTM test module 
with interactive style that allows 
you to use different series of 
SMUs in a safe connection to 
build a custom test. 3 kV bias 
tees and 200 V bias tees for the 
Model 4200 requires ACS 
installed on the 4200. No remote 
support. For CVITM, this requires 
KXCI and can be used from a 
remote computer, with ACS 
installed on the remote computer. 

Device specific 
HVCV PTM X √ √ √ √ √ X √ √ X X 

Includes built-in device-specific 
HVCV test libraries and test 
modules for a variety of devices in 
the ACS\Test Module 
Template\Device directory, the 
name of the file ends with the 
following: _HVCV. 3 kV bias tees 
and 200 V bias tees for the Model 
4200 requires ACS installed on 
the 4200. No remote support. 
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ACS 5.2 Features and Supported SMUs 

ACS Feature 

Instruments 

Notes 
2400 2600 2600A 2600B 2651A 2657A Virtual 

SMU 
42xx- 
SMU 

42xx- 
CVU 

237 2290 

General Purpose 
PTM 
(Combined_Test_ 
Mixed_SMUs.py) 

√ √ √ √ √ √ X √ X √ X 

Specific test module with 
interactive style that allows user 
to use different series of SMUs in 
a safe connection to build a 
custom test. Includes build-in 
sample test modules for variety of 
devices under ACS\Test Module 
Template\subsite directory, the 
name of the file ends with the 
following:  _MixedSMUs.  

Mixed SMU Pulse 
PTM (Mixed_SMUs_ 
pulselib.py) 

√ √ √ √ √ √ √ √ X √ X 

Mixed model of SMUs in pulse 
mode is mainly about the mixed 
use of model 2600, 2600A/B, 
265xA, 24xx, 237 and 42xx 
SMUs. Virtual SMU only supports 
combined two 2651A SMUs in 
PTM. 

Power supply library 
(PowerSupplyLib.py) X X √ √ X X X √ X X √ 

The power supply PTM supports 
for Models 2290-5, 2290E-5, 
2290J-5, and 2290-10 power 
supplies. This module can 
support the following SMUs for 
measuring the current through the 
device: Models 2611A/B 
2612A/B, 2635A/B, 2636A/B, 
4200-SMU, 4210-SMU. 

PTM √ √ √ √ √ √ √ √ √ √ √ 

Can write scripts using the Script 
Editor tool to achieve maximum 
speed form TSP-enabled 
instruments. Supports LPT 
commands. Includes build-in test 
libraries for a variety of devices.  

STM X √ √ √ √ √ X X X X X 

Can write scripts using the Script 
Editor tool to achieve maximum 
speed from TSP-enabled 
instruments. Supports LPT 
commands. Includes build-in test 
libraries for a variety of devices. 

CTM X X X X X X X √ X X X 

There are two kinds of CTM: ACS 
Classic Style and Advanced Style 
(Support CTM List). Classic Style 
CTM only contains one test 
module, but the advanced style 
CTM contains many test modules. 

ACS also supports these instruments: 

• Keithley 707/8A/B switches 

• Keithley Model 2010 DMM 

• Keithley 4200 CVU 

• Keithley Model 3700/3700A Switch/DMM 

• Agilent 4284 CV meter 

  ACS supports these communication interfaces: 

• GPIB* (NI and Keithley cards only) 

• LAN* (PTMs and CTMs are not supported for this 
interface) 

• TSP-Link subordinates 

*GPIB and LAN cannot be used simultaneously 
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Enhancements 

PR49831 Made SMU local and remote settings clearer. 

PR53360 Added gate off priority sequence for GaN device in 2600 ITM. 

Noncritical fixes 

PR54658 DIAGS: Incorrect FW version warning. 

PR54527 hwlimits.ini update can set 100A when forcing current in combined 2651A. Corrected SMU 
configuration files by replacing "HW_VER" with "FW_VER". 

PR45527 Corrected false RDS On failure during Universal Test for sensitive 2 wire systems. 

PR54521 Make it clear in documentation which probers are supported for post inking in ACS. 

PR54108 CC12K driver doesn't work correctly. (Pr_Init() ). 

PR54107 ACS formulator expression disappears. 

PR53640 Force auto scale in Wafer Level Plot (Overlays). 

PR53588 DIAGS: fix tests to not induce SMU latch-up condition. 

PR53587 DIAGS: switch back to 1mA for the matrix leakage tests. 

PR53586 DIAGS: Issues with settling on the HV Matrix leakage tests. 

PR53578 DIAGS: The command line -k sometimes misses pins. 

PR53577 DIAGS: Using diags -k option sometimes causes an unhandled exception. 

PR53573 DIAGS: Dielectric absorption keeps charge on PCA after matrix leakage tests, causing low-I range 
tests to fail. 

PR53572 Truncate "%Limit:" values in DIAGS and Verify tests to 2 digits after decimal for clarity. 

PR53570 DIAGS: System Verify .CSV results file should include limits and % of spec. 

PR53568 DIAGS: Update shadow.log buffer before pausing or stopping in diagnostics. 

PR53566 DIAGS: Add option to run individual stages of system verify. 

PR53564 DIAGS: 20-digit number when test fails with an overflow. 

PR53563 Add environmental variable to change voltage %limit for Diagnostic leakage tests. 

PR52781 Error message on 2612(Non-A) with ACS standard. 

PR48267 Error occurs when running ITM test and Start Ramp Step is selected in advance dialog. 
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PR47861 ACS reports calibrated SMUs as uncalibrated. 

PR47169 Export function in test tree should have data export option. 

PR45700 ACS RTM parallel cannot be used with 70xB. 

PR45681 ACS programmer manual: add example and note to help user effectively benefit from ACS global. 

PR45496 Formulator variables do not delete correctly in Wafer Level Plot. 

PR45324 Statistics: Will not attempt to load a file bigger than 600M. 

PR39264 Improved documentation for creating a TSP GUI. 

Known issues 

PR54578 No warning message reported when using the Model 2290-10 power supply and the interlock is 
disconnected. User must check interlock connection manually if voltage output appears wrong. 
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ACS Edition Version 5.1 

Overview  

Version 5.1 is the latest release of the ACS Edition software. 

Software compatibility 

You can use ACS software with Keithley Interactive Test Environment (KITE) software version 8.2 or later with no 
special configuration requirements.  

For GPIB driver compatibility information, see the ACS Edition Reference Manual (document number ACS-901-01). 
This manual is provided in PDF format on the ACS Edition CD-ROM that is included with your shipment of ACS 
software. It is also available in the Help menu of ACS within the software. 

New Features 

Added the S530 diagnostics and system verification tool (replaces previous ACS diagnostics project). 

Supports auto scan of the Keithley Model 2010 DMM (VMTR1, VMTR2). 

Added support for the Keithley Model 7072 HVD cards in hardware configuration. 

Added support for the Keithley Model 2604B, 2614B, and 2634B instruments. 

Supports instrument-to-instrument LPT function connections for conpin(), addcon() and delcon(): 

conpin(MTRX1,SMU1,VMTR1) or conpin(SMU1,VMTR1) 

addcon(MTRX1,SMU1, VMTR1) or addcon(SMU1, VMTR1) 

delcon(MTRX1,SMU1, VMTR1) or delcon(SMU1, VMTR1) 

Critical fixes 

PR51426 Fixed the issue when using an RS232 cable to control the EG2X prober while using two wafers and 
the software would cause the system to stop. 

PR51199 Fixed "invalid literal" error when selecting matrix slot1, column 1 to 9. 

PR50217 Fixed the ITM negative log sweep that caused the S530 test system to stop functioning. 

PR50187 Fixed the issue where the S530 test system could not pass the contact check when 'Automatic 
Contact Check' is selected. 

PR50071 Repaired the issue when the LPT rangeX automatically sets the source limit value of the 26xx 
SMU. 

PR48613 Fixed the issues when an ITM causes an error when two SMUs are sweeping and reach 
compliance. 

PR48612 Corrected the issue when aborting a sweep causes the system to stop. 
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Features and Supported SMUs 

ACS 5.1 Features and Supported SMUs 

ACS Feature 
Instruments 

Notes 
2400 2600 2600A 2600B 2651A 2657A 42xx-SMU 237 

Automatic 
hardware scan 
and configuration 

√ √ √ √ √ √ √ X 
Model 237 must be manually added as an external 
instrument. 

ITM X √ √ √ √ √ √ X 

The 2600 ITM supports Series 2600A/B trigger 
model and it supports both DC and pulse 
measurement. It also supports 265xA high-power 
SMUs in a safe configuration. Includes sample test 
modules for a variety of devices in ACS\Test 
Module Template\subsite directory. 
The Model 4200 ITM only supports DC 
measurements. 

General Purpose 
PTM √ √ √ √ √ √ √ √ 

Specific test module with interactive style that 
allows you to use different series of SMUs in a safe 
connection to build a custom test. Includes sample 
test modules for a variety of devices in ACS\Test 
Module Template\subsite directory. 

CTM X X X X X X √ X 

Two types of CTMs: ACS classic style and 
advanced style (support CTM list). Classic style 
CTM contains one test module, but the advanced 
style CTM contains many test modules. 

STM X √ √ √ √ √ X X 

Can write scripts using the Script Editor or Test 
Script Builder tool to achieve maximum speed from 
TSP-enabled instruments. Supports LPT 
commands. Includes device test libraries and 
wafer-level reliability (WLR) library in 
ACS\library\26library directory. 

PTM √ √ √ √ √ √ √ √ 
Can write scripts using the Script Editor tool to 
achieve maximum speed from TSP-enabled 
instruments. Supports LPT commands. 

ACS-2600  RTM X √ √ √ X X X X 

Includes HCI and NBTI, Fast-NBTI, Time 
dependent dielectric breakdown (TDDB_CVS). 
Voltage ramp (Vramp). Ramped current (Jramp). 
Electromigration (Iso_EM) and Poly_Heater 
modules. Includes VDS Sample Tests in ACS\Test 
Module Template\device\Vds Reliability directory. 

ACS also supports these instruments: 

• Keithley Model 2010 DMM 

• Keithley 4200 CVU 

• Keithley Model 3700/3700A Switch/DMM 

• Agilent 4284 CV meter 

ACS supports these communication interfaces: 

• GPIB* (NI and Keithley cards only) 

• LAN* (PTMs and CTMs are not supported on LAN) 

• TSP-Link subordinates 

*GPIB and LAN cannot be used simultaneously 
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Enhancements 

PR51197 Added the Model 70xB firmware version check. 

PR50247 Integrated the Model 2010 DMM into ACS. 

PR51094 Added the Model 2010 DMM User’s manual to the instrument reference folder. 

PR50576 Corrected a handshaking issue with the CC12K prober driver. 

PR47776 Added instructions on how to import Vds reliability tests to the ACS Reference manual. 

PR49991 Eliminated unnecessary chuck up/down commands when performing prober moves in ACS 
(AR37822). 

PR41820 The cassette map information is saved by default for all wafers when you create a new a project. 

Noncritical fixes 

PR51238 Fixed intermittent SMU mapping error during hardware scan. 

PR50872 Updated the ACS Reference manual with the ACS_run_mode for UAP variable. 

PR50292 ACS software installation and modification is not tracked in KATS\install.log. 

PR50216 Fixed the issue that caused the completion message to be hidden after "Delete All Scripts" was 
run. 

PR50215 Repaired the ACS LPT crtbf() constant values KI_XXXX so that they are functional. 

PR50189 Fixed the Preference settings in operator and engineer mode so that they are the same. 

PR48362 Fixed the issue where LPT addcon used more matrix rows than necessary. 

PR48315 Fixed the issue with overwriting usrlib.mak on systems where KTEI is installed. 

PR47815 Fixed the issue with the "Show Real Time Plot" button so that it is not masked when "save plot 
automatically" is selected. 

PR47184 Fixed the combined SMU settings dialog so that the series (80V, back-to-back) in not an option. 

PR47170 Revised the default location for the "Export" dialog box. 

Known issues 

PR51288 The diagnostics tool does not fully support two-wire systems. 

PR50218 In ACS, when you save an .xls file, the size is large; however, if you open and save file again, it will 
reduce the file size. 
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ACS Edition Version 5.0 

Overview  

Version 5.0 is the latest release of the ACS Edition software. 

Software compatibility 

You can use ACS software with Keithley Interactive Test Environment (KITE) software version 8.2 or later with no 
special configuration requirements. 

For GPIB driver compatibility information, see the ACS Edition Reference Manual (document number ACS-901-01). 
This manual is provided in PDF format on the ACS Edition CD-ROM that is included with your shipment of ACS 
software. It is also available in the Help menu of ACS within the software. 

New Features 

Supports auto scan of the Keithley Model 2657A instrument. 

Supports auto scan of the Series 2600B instruments (Keithley Models 2604B, 2614B and 2634B are not included). 

Enabled the Keithley Model 2651A and 2657A instruments in an ITM and mixed SMUs in a PTM. 

Hardware configuration GUI updated to support the composite Keithley Model 2651A SMUs for 100A testing and 
80V testing (100A for a parallel connection, and 80V for a series connection). 

Added a CVU compensation tool in the Tools menu (for the Keithley Model 4200-SCS KTEI v9.0). 

Added support for the Keithley Model 3706A as a parent or child instrument. 

Added Vds reliability test modules to the following computer hard drive directory:  
ACS\Test Module Template\device\Vds Reliability 

Added ITM and PTM sample test modules to the computer hard drive directory: ACS\Test Module Template\subsite 

Updated S530 diagnostics and confidence check tests: 

• Increased matrix diagnostic coverage and support for a blank probe card and a short probe card. 

• Confidence check is available in ICL mode. 

• Diagnostics and confidence check support for the Keithley Model 7530 card. 

• Supports diagnostic and confidence check for the Series 2600B instruments.  

• Updated the confidence check specifications file to distinguish different pathways. 

• Account for the S530-PM resistance for both confidence check and diagnostics. 

ITM GUI updated for the Series 2600B Instruments trigger model and Keithley Model 265xA support. 

Timing window updated and added a 'Single Point' and 'Entire Step/ Sweep' mode for the pulse transient in an ITM. 
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Added mixed SMU PTM support: 

• Upgraded the Combined_Test_Mixed_SMUs.py file for the Keithley Model 265xA (it is completely 
supported in DC mode). 

• Added the Mixed_SMUs_pulselib.py file and some test modules that support the Keithley Model 265xA and 
non-26xx models in pulse mode. 

 

Updated Ultra-Fart BTI to allow the RPM to work in bypass mode so the PMU can work in high voltage mode to 
source up to a 40V signal. 

Added a 'Legend settings' feature to the plot function (right-click in order to see the legend settings menu). 

Critical fixes 

PR47408 ITMs running repeatedly no longer cause system memory related crashes. 

PR47357 Formulator results are displayed in the wafer-level plot overlay mode. 

PR47356 Licensekey.txt file license is valid without a network connection. 

PR47326 Loop number can be saved on the subsite level. 

PR47257 ACS graph "Valid for Series" produces more than 10 output combinations. 

PR46973, PR45959  Forcing voltage to the KI236/237 is possible. 

PR46972 PTM GeneralTestLib functions appropriately with KI236. 

PR46848 Appropriate error message appears, if an error is found in pulse_exec() lpt during a BTI test. 

PR46648 Fixed existing issues with switchctrl.py. 

PR46482 Added rpm_config call to the beginning of the BTI test within the module. You will not be required 
to manually run the PTM rpm_config anymore. 

PR46023 ACS launches correctly when a Model 70xB is connected as the master. 

PR45847 Jramp will execute a current ramp. 

PR41821 When you select a set of wafers, only the wafers that you choose for testing will create an output, 
instead of all the wafers that are on the cassette. 
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ACS Features and Support SMUs 

 

 

Enhancements 

PR47442 Added a ‘Summary Report’ checkbox in the preference settings dialog for those who have 
administrator rights in order to enable or disable the summary report for an ACS operator. 

PR47366 Added support for the Model 3731 matrix card. 

PR47328 Changed the default Export/Import directory path for the ‘Test Module Template’ and also changed 
the path in the preference settings dialog. 

PR47320 Added support for the following probers: Signatone and Yang Sagi3. 

PR46854, PR46856 Added support with KTEI v9.0, including support with a Model 4225-RPM-LR. 

PR46336 Added an option in the ACS_Setting.ini file so that you can automatically save an ACS log 
window message. 

PR46118 Added support to the user access point (UAP) execution to an ITM and STM, if a manual test is 
performed. 

PR45862 Added RTM voltage ramp resistance (Vramp protect R) compensation. 
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PR45861 Added RTM time-dependent dielectric breakdown, constant voltage stress resistance (TDDB_CVS 
protect R) compensation. 

PR45827 Changed the ACS STANDARD license edition to WLR. 

 

Noncritical fixes 

PR47422 When you change the output parameters for your testing, the data and plot are updated. 

PR47409 The confidence check test is included with the diagnostic test project. 

PR47389 Generate Report creates a readable, plain text, format report. 

PR47282 If you export a sample test from a subsite or a device level, an “Include Test Data” checkbox has 
been added to facilitate with exporting the associated data. 

PR47278 You can load a Model 237-HV HCI test module in ACS. 

PR47222 Corrected the Automation dialog options for the P8 Prober. 

PR47213 Added diagnostic fixes for the S500 and S530. 

PR46180 Signatone Prober is labelled in the dropdown menu. 

PR45837 ACS aborts installation if it detects that KITE is running. 

PR45836 Created an individual sysconfiginfo.ini file in ACS to ensure it does not overwrite KITE's  
  prober file. 

PR45644 The UAP GenerateExcelFile.py functions properly. 

PR45618 Fixed the automation cassette color to match the results from the test. 

PR45545 Pin assignments are saved once they are entered. 

PR45493 'Hold time' works with an ACS-ITM with a Model 4200 SMU. 

PR45059 Added the “Limited Auto” function to the GeneralTestLib for a Model 26xx. 

PR43885 Added an Export/Import button to the matrix GUI that allows you to save the pin mapping. 

PR43484 Fixed the LPT connection that is made while using multiple DDC mode with Models 707/708 
matrices. 

PR47283 Removed the 'Restore default location' button from the Export dialog. 

PR47280 Changed account information ‘operator’ name to ‘user name' in the property fields. 
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Known issues 

PR47625 The error ‘-286 TSP Runtime Error’ occurs when connected to 2600 instruments and TSP-Link 
nodes are not sequential numbers. ACS only supports nodes that are sequential numbers, such as 
1, 2, 3, 4, etc. 

PR47287 The error “26xx timeout occurred in engine: engine4” may occur which means ACS will not be able 
to retrieve the GPIB KPCI-488LP card status in a frequent communication environment. 
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ACS Edition Version 4.4 

Overview  

Version 4.4 is a maintenance release of the ACS Edition software. 

Software compatibility 

You can use ACS software with Keithley Interactive Test Environment (KITE) software version 8.2 or later with no 
special configuration requirements.  

ACS software features 

Supports 2600-based-RTMs, includes HCI, Fast-NBTI, TDDB_CVS, VRamp, JRamp, Iso_EM, Poly_Heater and 
Stress_Migration modules. (Need ACS-2600-RTM package license, ACS-2600-RTM is not available in ACS 
Standard Edition or using 30-day temporary license). 

Requires ACS-2600-RTM package License. The 2600-based-RTMs not available in ACS Standard Edition. 

Added the Model 2651A instrument support. When connected properly, the instrument will be scanned and added 
automatically within the Hardware Configuration. 

Added 2651A sample library ‘Sample_2651A.tsp’ under 26 TSPLib folder. 

Added sample libraries/projects, includes 237-HV Reliability test modules, Stress Migration, Charge Pumping and 
Pulse Stress Measure Loop. 

Improved throughput with Model 707B chassis integration. 

Standard Kelvin configurations for both low-current and high-voltage. 

(S530 Systems only)System specifications to the PCA (Probe Card Adapter), including CV. 

(S5xx Systems only) Industrial PC with clean XP install (no consumer "starter" software). 

S400 conversion tool. 

Command line execution of common ACS project and automation functions. 

Support for both DDC and ICL modes for Models 707B and 708B. 

Prober chuck connection when using a switch matrix. 

Perform diagnostic testing (for the S530 System only). 

Ultra-fast BTI reliability testing that uses AC and DC reliability stress and measure techniques. 

Statistics capability. 

Debug Python modules. 
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Supports both symbol and 3-dimensional bitmaps. 

Supports Python, Test Script Processor (TSP™), and C programming languages. 

Available operator and engineer operation modes. 

Performs common transistor parameter testing (for example, Vds-Id, Vgs-Id, Vg-Ig). 

Performs life testing (TDDB, NBTI, HCI) using various projects. 

A script editor tool allows you to view and edit test code and export it into TSP and Python language libraries. 

Supports standard, XRC, and customized graphical user interfaces (GUIs) for PTMs and STMs, and can bind 
events in customized XRC styles. 

XRC GUI Builder tool allows you to edit and view GUI layout for XRC format. 

System information can be accessed and saved into a plain text file (.txt). 

A system verification project can be opened from the help menu with connection information in an accompanying 
PDF.  

CV, KI237, KI23X, KI24XX, KI37XX, and SWITCH libraries are supported. 

 

Enhancements 

Added Windows 7 x86 (32-bit) and Windows 7 x64 (64-bit) operating system support. 

Enhanced modules to include the 2600-based RTM for HCI, Fast-NBTI, TDDB_CVS, VRamp, JRamp, Iso_EM, and 
Poly_Heater. 

Added the Wafer Level Reliability Test and ACS-2600-RTM Manual in ACS v4.4. 

Removed the default password ACSADMIN, and there is no default password for ACS V4.4. 

Added the JRamp and TDDB test modules that support linear time, log time, and Vgate shift for data compression. 

Updated BTI projects to support a total of six PMUs for KTE v8.2. 

Added the Stop on Compliance function for the 2600ITM, 4200ITM, and mixed model SMU ITM. 

Added 32 pin devices for the 2600-based RTM tests. 

Added a ‘Copy 1st to all’ function, which will copy the first setting of sub-device1 to all the other sub-devices. 

Added the ability for you to set up automatic updates to the real-time plots. 

Added the ability to delete the temporary log file and a new one created whenever you start ACS. 

Added the option to sort 2600-based RTM test data output to generate a .csv file according to the new order. 

Support prober P300A. 



 Automated Characterization Suite (ACS) Release Notes 
 

PA-1008 Rev. L / November 2017 33 

 

Upgraded the USB license key driver in order to support Windows 7 operating system. 

Upgraded the GeneralTestLib.py and added step setting. 

Added dual sweep and log sweep for the 4200 ITM. 

Added a function that saves test data and test status to a .xls file for manual testing on the data page. 

Support ACS RTM UAP execution for manual testing. 

Added a .csvbak file that backs up your .csv file in order to accomplish manual testing. 

Added the ability to configure the plot to refresh automatically or manually, for the 2600-based RTM tests. 

Added an Export Data function in the real-time plot window. 

Added the ability to save a .csv file while running an RTM test. 

Added tests to the S530 Diagnostic and Confidence Test rows B to C, D to E, and F to G. 

Changed settings so that the .csv file is bound with the project. 

Added 45,135, 225, and 315 degree for the wafer notch. 

Allow changing of wafer flat or notch location without coordinating transformation. 

Ability to detect matrix errors as soon as they are encountered. 

Added function to identify Idsat in ACS-2600 RTM HCI test. 

Added searchX function to PTM and STM lptlib. 

Critical fixes 

Updated the ACS Reference manual and created a new ACS 2600-based RTM User's manual. 

Added pulse_remove() to the ktmserver.exe file to fix BTI abort issues. 

Optimized the hardware scan using multiple threads to scan the hardware instead of a single thread. 

Added an XY setting 'Valid for Series' in the 2600-based RTM tests for the data plot. 

Added +,-,*, /, ^ expression to the HCI and Fast NBTI global variables. 

Repaired the memory error when loading a .kdf file in the wafer level plot or in statistics. 

Repaired the JRamp problem that does not perform the ramp. 

Repaired the ACS ITM Current Sweep setting problem. 

Repaired the HCI measure global expression so that it can be edited without inserting a global dialog. 

Repaired the formulator so that it can be removed for the ITM step function. 
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Repaired the ACS RTM TDDB_CVS error that occurred when the test finished. 

Repaired the HCI and FS_NBTI tests that the fast clicking stress panel 'maximum recursion depth exceeded' so 
that it will no longer cause errors. 

Repaired the ACS RTM VRamp so that the last data sweep is correct. 

Repaired the ACS RTM JRamp Formulator functions so that they do not disappear. 

Repaired the ACS RTM JRamp Formulator so that the results are available after finishing the test. 

Repaired the Formulator function so that you can run a test on an RTM and after testing, you can add another 
formula, if needed. 

Repaired the ACS RTM WLR Formulator so that the results will display on the data sheet. 

Repaired the ACS RTM HCI WLR Formulator so that the results will display in the target setting. 

Repaired the memory error when switching from the definition to the Data tab after the test has stopped. 

Added an "Invalid" message that pops up when adding a new account and deleting it then restarting ACS with the 
user name ACSADMIN. 

Repaired the wafer map so that updates are in real time. 

Repaired the settings so that the loop number can be set to 0. 

Repaired the TDDB so that when the monitor measure takes a significant amount of time, and the test cannot be 
stopped, data for the subordinates will still be collected (both GPIB and LXI). 

Repaired the TDDB so that when the sample interval is .1 second of Group 1 (for example, 1 group*4node), the 
real-time sample interval will be correctly set. 

Repaired the HCI GUI so that the Compliance option is updated after making an edit. 

Repaired the TDDB runtime error -286 problem. 

Repaired the General TDDB_CVS script TSP Syntax error. 

Repaired the ITM on the device level so that the ITM Data sheet will display the correct result. 

Repaired the id_vg module in the default project so that the data sheet will display correct data after running a test 
and the data will get appended. 

Repaired the VRamp so that it can return the correct data 'Tbd' when the device breaks down. 

Repaired the VRamp return status error so that if the devices break down reaching the Qmax problem. 

Repaired the subsite GUI so that it will display correctly after changing the subsite name and deselecting the Apply 
function. 

Repaired the inability to re-scan hardware due to the ACS not responding when there is a GPIB conflict. 
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Repaired ACS so that it will start if a Model 4200 is defined in the ACS preferences and there is a KXCI (or other) 
error. 

Repaired ACS so that the configuration parameter that defines the windows directory path is missing or does not 
contain the paths to ndcore.dll or common.dll, it will now start. 

Repaired the sweep issue if the Model 237 stops running. 

Enabled ACS so that it will run all C Test Modules (CTM). 

Repaired the PTM GUI so that it does not disappear. 

Repaired the data output issue that affects the .csv file. 

Repaired the TDDB so that a 100pA measurement range can be used. 

Repaired the VRamp so that SMU1 and SMU2 can ramp voltage when other SMUs finishing ramping. 

Repaired the RTM VRamp partial data dropping problem. 

Repaired the statistics plot zooming function. 

Repaired the SMU Commands Calling during the CVU Test problem. 

Repaired the FastNBTI so that the down ramp of the post-test will work correctly. 

Repaired the aborting problem that ACS software causes for instruments if KITE goes offline. 

Repaired the Python getcommon() command so that it includes system attributes. 

Repaired the conpth and conpin commands to allow for dangerous connections. 

Repaired the Fast NBTI spiking and hanging problem. 

Repaired the ISO_EM test so that it will not stop before meeting any failure criteria. 

Enhanced the SWEAT output file. 

Added a prompt continue or stop dialog box if a prober error occurs. 

Non-critical fixes 

The .kdf and .db file configurations depend on the project instead of the platform. 

The VRamp function allows you to set the real-time post data condition (for example, the time to post and the data 
points to post). 

Added an upgrade plot setting checkbox in the preference settings. If selected, it will update lines when the axis 
settings change. 

Added the ability for ACS to generate temporary files at all times for your reference, if needed. 
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Saving CSV file related optimization: 

1. Optimized memory management and enhanced manual run to saving csv file. 

2. Optimized memory management and speed up saving automation csv file.  

3. Changed saving automation csv files from kdf folder to csv folder. 

4. Changed automation csv files saving configuration from KATS_Pref.ini to project, the settings will bound 
with project. 

5. Added basic test information into the header of csv file, including ‘Lot name', 'Wafer id', 'Project name' and 
'Time'. 

Added the system User environment and can save in support info file. 

Added and enabled a DMM function to the MDD.py module. 

Repaired the TSP matrix lpt functions; "Chuck" can be correctly connected. 

Repaired the python matrix lpt functions, 2410 SMU can be connected to multi pins now. 

Enabled the 2400 beeper for ACS V4.4. 

Enabled the BTI setting stored in output files.  

Repaired the RTM polyheater default CompI value of HeatLo. 

Repaired the ITM that Vprog log value is rounded. 

Repaired the Save as template that it no longer copies data folder. 

Added an error check in HCI exit/target condition value to force user input positive value. 

Added an error check to HCI Stress V when Stress V is nil. 

Repaired the HCI formula for a proper definition of VTCI_LOG10 first parameter "U."  

Repaired the HCI sweep measure source range setting error when using best fix. 

Repaired the HCI formula that can be correctly generated when changing sweep measure to sample measure. 

Added the correct definition to SSVTCI in Data tab formulator. 

Repaired the Formulator VTCI_LOG10 of data tab. 

Removed the Data Tab formulator PCTSHIFT_T0. 

Added a message when copy first to all failed in HCI. 

Repaired the HCI GUI check for on/off sequence if shared Gate. 
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Repaired the HCI & FS_NBTI percentage shift mode that it is functional when the using the result of 
PCTSHIFT_T0(). 

Changed the ACSPostArratDouble output value to 12 digits. 

Repaired the TDDB_CVS take data twice at last of stress problem. 

Enabled the FS_NBTI RTM to insert global data in Inter Stress item. 

Enabled the execendseting flag and defaultrange flag for single unit. 

Repaired the Graph spread over screen by moving separator problem. 

Repaired the HCI device2's tab displays while only 1 sub device under test problem. 

Added some limitations for RTM modules in Statistics. 

Enabled the ability to easily remove and add the same external instrument with the same GPIB address. 

Added a clear message when pre_test removes while global variable induced in meas for HCI. 

Added an error check for device name and pad name in device edit tool. 

Added an entrance for attribute T when multi devices test in HCI. 

Added a GUI check for stress time setting in HCI. 

Repaired the BTI script generation when not all subdevices selected for test. 

Repaired the TDDB test is running without end when Points setup to 1 in linear mode problem. 

Added a scrollbar enhancement for BTI stress settings. 

Repaired the X,Y value in offset settings. 

Enabled the re-sort button to be grey while RTM test running. 

Disabled the points if you select list of Time Array in TDDB GUI.  

Repaired the ITM sweep setting changing when changing Measure item problem. 

Repaired the JRamp missing last points when only using Vgate shift data compression problem. 

Disabled the auto scroll of scrollbar in GeneralTestLib. 

Repaired the TDDB that power off and relay off can be done when subdevice failed in parallel mode. 

Repaired the JRamp missing the last data when devices breakdown by using data compression problem. 

Repaired the JRamp to return correct breakdown data when it is stopped by compliance. 

Added an error check for TDDB_CVS GUI List mode with Insert: every stress section should be >=0.1s. 

Repaired the VTISUBMAX disappeared from HCI formulator dialog problem. 
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Repaired the JRamp Sample interval for all the devices are not the same problem. 

Added an error check for Lowest V and Max Q in JRamp panel. 

Added an error check for PLC value in JRamp GUI. 

Repaired the VRamp set up test module Sequential mode and Parallel mode is disabled problem. 

Repaired the VRamp, Sample interval for all the devices are not the same problem. 

Enabled all SMUs of Group 1 can be assigned to Pad. 

Repaired the BTI test module, that if there are two formula you can change the sweep value. 

Repaired the RTM that subdevice1 can be removed from test. 

Repaired the devint() and clrcon() when using GPI and Matrix together. 

Enabled enough digits of Compl input for HCI&FSNBTI GUI. 

Repaired the Formulator in offline data plotting that it has the same function of formulator in Data Tab. 

Increased the speed when you apply the binning settings when many parameters are selected. 

Enabled the disabled items can be selected. 

Reworded the warning message when scan hardware. 

Repaired the HCI/NBTI and FS_NBTI insert global data error problem. 

Repaired the Hardware tooltips that they match in hardware change info window. 

The 'Login In Demo Mode' checkbox is selected by default when ACS starts. 

Added a message "ACS folder already exists, do you want to replace it" dialog box when ACS is reinstalled. 

Updated the GUI for the HCI RTM. 

Repaired the ACS4.3 Manual bug for HCI/NBTI timing dialog. 

Repaired the formulator vector functions. 

Repaired the problems that occurred when aborting test sequences that use the PMU. 

Repaired the array plotting from S4200Parlib to be orderly. 

Enhanced the ACS Prober Reference message. 

Enabled the filter of 4200 ITM. 

Changed the Delay Factor in 4200 ITM to "Sweep Delay." 

Added a status flag as result for Em_iso_test.tsp. 
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Placed the bsweep, trig correct place in manual. 

Changed the note in Diagnostics module. 

Repaired the spelling error of "SLot." 

Enabled the prober returning to the home position in single wafer mode. 

Repaired the mismatching in cassette info. 

Repaired the CVU locked when several times run system mode test without reset and reconnect KXCI problem. 

Repaired the Program not responsive or “hang" problem. 

Enabled the NBTI supporting TAR_IATV(). 

Enabled the NBTI supporting VTCI_LOG10(). 

Disabled the General Purpose Instrument to follow matrix Common LO/Independent LO scheme. 

Added a Qbd log stress value as attribute. 

Repaired the ACS data disappearing in trial operation problem. 

Repaired the ACS wafer level plot problem. 

Added a function to find out Qbd breakdown in ACS and KDAT. 

Added a breakdown judgment to limit lowest voltage in JRamp. 

Enabled the Chuck_Force items in 3730 column. 

Repaired the 237 is not recognize after configure Hardware problem. 

Repaired the axis title and axis values overlap if more than 1 plot problem. 

Added an error checking for Groups and associated SMU's. 

Added a bsweep Python lpt for 4200.  

Enabled the 2410 over-temperature error displayed in ACS. 

Repaired the prober button is masked by abort operation problem. 

Removed the cassette map information in the project. 

Enabled the writing data to kdf after each device. 

Known issues 

The KI2651A instrument model is not supported within an ITM and 2600-based-RTMs. 
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In Windows 7 operating system, you will need to keep the network cable plugged-in if you are using a license file. If 
the network cable is removed, ACS consider your license file invalid. 

In Windows 7 operating system, when you install software or update the USB license key, you may encounter a 
User Account Control (UAC) error. If you encounter this error, click the Yes button to continue and perform the 
following steps to turn off the UAC error: 

1. Go to Control Panel -> User Account and Family Safety -> User Accounts. 

2. Select a user then click Change User Account Control setting. 

3. On setting dialog, move the notify slide to Never notify and click OK to save it. 

ACS cannot scan instruments when the Series 2600A firmware is version 2.1.6 and a 2600A instrument is the 
master to a Model 2651A using a TSP-Link cable. You can refresh the 2600A firmware version to 2.1.3 or 2.1.1 to 
solve this issue. 

NOTE If you have ACS v4.2 or earlier software installed on your PC and you are updating to the newest version 
of ACS, you will need to perform the following operations first: 

1. Uninstall the previous version of ACS. 

2. Go to the C:\S4200 directory on your computer and rename it to C:\S4200_old (NOTE: this only applies if 
you are NOT installing ACS directly on a Model 4200A or 4200). 

3. Remove the C:\ACS\KATS\KATS_pref.ini file. 

4. Install the newest version of ACS. 

If you cannot run the CTM after it has been complied by Visual Studio 2008, you will need to upgrade to NI-VISA 
runtime version 4.6. 

If any of the matrices in the system are set to Remote Sense or the S530 Kelvin mode, all of the Series 2600A and 
Series 2400 instruments in the system will be set to four-wire (4-W) mode when executing a test. Also, the SMU 
Remote Sense option box in the Preference settings Misc tab will be disabled. When all the matrices are set to 
Local Sense, all of the Series 2600A and Series 2400 instruments in the system will be set to two-wire (2-W) mode 
when executing a test. It is highly recommended that all the matrices in the system are in the same mode. 

Support for the confidence check of the Model 707B matrix only in DDC mode. 

After ACS has been launched, user do not plug-out and plug-in USB GPIB cable from computer, even the USB 
cable plug-in again, ACS still lost hardware control, user need to restart ACS to solve it. 

If installing the NI GPIB driver NI-488.2 v2.7.3 or above, the NI VISA driver option is not selected as the default. 
You must choose the NI VISA option when installing the NI GPIB driver. If the NI VISA driver is not installed, the 
instruments may not respond when running a PTM. 

ACS only supports CEC488 GPIB drivers 8.2 or above. If older drivers exist, you will need to upgrade. 

The @ symbol is a key character used in ACS. It should not be used in ACS_PostData, including 
ACSPostDataFloat, ACSPostDataDouble, ACSPostArrayInt, and ACSPostArrayFloat, etc.  



 Automated Characterization Suite (ACS) Release Notes 
 

PA-1008 Rev. L / November 2017 41 

 

Based on license mode of the USB key inserted, you can access the different modes available in ACS (for 
example, Standard, WLR, and RF). 

While importing the Model 4200 project files, if the subsite does not have any libraries and modules described then 
importing the .kpr (Keithley Project File) will fail (you will receive an error). In addition, the devices imported will 
appear incorrectly.  

By default, the beeper is disabled when executing a module. If you want to disable/enable the beeper when running 
a module, refer to the following steps:  

1. Open the file ACS_setting.ini (in the KATS folder in the ACS file directory).  

2. Find “enable” that is under the item "beeper", beeper->enable.  

3. Set the value to 1 to enable the beeper; set the value to 0 to disable the beeper.  

4. Save the file and the configuration is effective immediately. 

Within the BTI Project, and its corresponding modules, the maximum segment number per channel is 2048.  

If you receive a .dll conflict error during ACS installation, shutdown the UTMServer or the KTMServer. If they exist 
in the task manager, then click Retry to continue the installation.  

If you uninstall or reinstall KITE or GPIB drivers after ACS has been installed, ACS may not function due to .dll 
errors. To resolve this issue, you will need to reinstall ACS.  

If you uninstall the NI driver and software, you must reinstall ACS.  

If you want to use the Model 4200-ITM or Model 4200- CVU, the version of KXCI must be v8.1 or newer.  

On the Model 4200-SCS instrument, if you run a PTM immediately after running an ITM for the Model 4200-SCS, 
you will need to add the statement Get4200HWCtrl() to get control of statements in the module. The GetHWCtrl() is 
in the ACS_PostData module.  

On the Model 4200-SCS instrument, if you stop a test and the LED stays on, you will need to close ACS and reset 
the hardware (in CMD line, run resethw) for the Model 4200-SCS, then restart ACS.  

On the Model 4200-SCS instrument, if you do not want KXCI to start when you open and run ACS, you can change 
the setting in the .ini file to avoid unnecessary hardware conflicts. You must set the start_kxci value to 0 in the 
ACS_setting.ini file to stop KXCI from running. For example, if you run CTM automation and stop the test 
before it’s finished, you may need to restart ACS because of a hardware usage conflict between CTM and KXCI.  

ACS does not support a remote connection, such as a terminal server, VNC, Windows XP remote client, etc. with 
the USB license key. If you have a requirement to use a remote connection, contact Keithley Instruments, Inc.  

In a parallel 2600-based-RTMs test, at least one subdevice with a SMU as the master node has to be selected.  

Since the release of ACS version 4.0, ACS will dynamically load the system script for UAP when running RTM 
projects. If you have an older version of ACS and install a newer version, you will need to delete preload all, delete 
all and collectgarbage UAPs before running RTM projects inherited from the previous versions.  

In the Device settings, every Pad Name subdevice must have the correct format (refer to the ACS Reference 
manual for more details).  
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For a real-time plot and data display, if the volume of data is large, it may take several seconds for the data to 
update, or may cause the software to stop functioning. For example, if the real-time timer interval is set to update 
every 1 or 2 seconds, it may cause the software to not function properly. You can change the timer interval, if 
needed, in the ACS_setting.ini file.  

ACS does not support mixing Series 2600A instruments with Series 2600 instruments with the DTNS operation 
which includes RTM parallel modules.  

When ACS is installed on the Model 4200-SCS and KITE is upgraded to v8.1, you must delete the ieee_32m.dll file 
in the following location: C:\windows\system32. Once deleted, you must reinstall the CEC488 GPIB driver v8.2.  

If you encounter an error you need help with, go to the Help  Troubleshooting  Zip Support Info. The zipped file 
is saved to ACS\KATS\support_info. Send the information file by e-mail to the following address: info@keithley.com  

ACS only supports the English language. Errors may occur when saving and opening ACS files if characters from 
other languages are within the names of directories on the computer. 

Troubleshooting ACS 

NOTE: Choose one of the following tasks to solve the problem. 

• Common.dll error that will not allow ACS to open. 

When you start ACS, the Command.dll error will pop up and the kits.exe.log file will generate in C:\ACS\KATS\. 
The error in kits.exe.log as below: 

 Traceback (most recent call last): 

    File "kits.py", line 25, in ? 

      File "hardwareinteg.pyc", line 44, in ? 

     File "ACSLPT.pyc", line 6, in ? 

    File "KIGPIB_KATS.pyc", line 12, in ? 

    File "KIGPIB_KATS.pyc", line 10, in __load 

 ImportError: DLL load failed: The specified module could not be found 

• If you do not shut down and restart your computer after installing ACS, it will not function properly. 

Reboot your computer. Launch ACS. 

• Problems may occur after reinstalling KTEI. 

Check the C:\S4200 directory. The C:\S4200 directory should not be absent or renamed. 

If the C:\S4200 director is renamed, rename it back to C:\S4200. (NOTE: this only applies you are not removing 
KTEI when you are install ACS on a Model S4200-SCS) 

If the KTEI version is removed or reinstalled, you need to reinstall ACS. (NOTE: ACS and KTEI version share 
some .dll files. You must install KTEI first and then install ACS.) 
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Launch ACS. 

• Problems may be caused by improper environment variables. 

ACS user environment value path maybe changed by other of other software packages. . 

Run ‘Initialize New User’ tool from Start -> Program -> ACS X.X. (Recommended) 

Reboot your computer after new user initialization is complete. 

Launch ACS. 

Also, you can manually check the user environment and modify value path (Advance). 

Go to C:\ACS\KATS\ACS_Env.txt and open it. 

Go to My Computer > Properties > Advance page, click user environment button to open environment dialog, 
compare the user environment value path with ACS_Env.txt file, the path, and pyLibrary etc. value path should exist, 
especially keep the ACS related value path keep in path header, for example the path value as below: 
C:\ACS\KATS; C:\S4200\sys\bin; C:\S4200\kiuser\usrlib; C:\S4200\sys\openint\dll 

Click OK to exit user environment dialog. 

Launch ACS. 

• Problems may occur when launching ACS from a different Windows user account. 

Log into new user account. 

Ensure you have C:\access rights. (NOTE: this only applies windows limited users without C:\ access rights) 

Run ‘Initialize New User’ tool from Start > Program > ACS X.X. 

Reboot your computer after initialize user finished. 

Launch ACS. 

• Problems may occur from other software common.dll files. 

Here is an example of the kits.exe.log error: 

 Traceback (most recent call last): 

    File "kits.py", line 24, in ? 

    File "hardwareinteg.pyc", line 31, in ? 

    File "ACSLPT.pyc", line 3, in ? 

    File "KILPT.pyc", line 12, in ? 

    File "KILPT.pyc", line 10, in __load 
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 ImportError: DLL load failed with error code 193 (xxx) 

Go to C:\S4200\sys\bin\ directory and check if the command.dll exists. 

Search command.dll in hard drive (for example, the "C" drive) and ensure multiple common.dll files exist. 

Go to My Computer > Properties > Advance page, click user environment button to open environment dialog, the 
following S4200 related path value should exist in path: C:\S4200\sys\bin; C:\S4200\kiuser\usrlib; 
C:\S4200\sys\openint\dll 

ACS does not open. 

• ACS fails to launch. Only a kits.exe.log file is generated. 

Launch ACS, the error occurs and a kits.exe.log file is generated in C:\ACS\KATS\. 

The error in kits.exe.log is as below: 

 Traceback (most recent call last): 

  File "kits.py", line 24, in? 

  File "hardwareinteg.pyc", line 31, in? 

  File "ACSLPT.pyc", line 7, in? 

 ImportError: No module named ptmlpt.constantlpt 

• Problems caused by a pyLibrary value path error. 

Go to My Computer > Properties > Advance page, click user environment button to open environment dialog, the 
pyLibrary value path should match ACS install path: C:\ACS\library\pyLibrary 

Modify the value path and click OK to exit. 

Wrong version of ACS opens. 

• Problems may occur when you rename the ACS file directory: renamed C:\ACS_xx directory.  

If you renamed C:\ACS_xx directory, change it back to C:\ACS. 

Launch ACS from start menu or desktop icon, the problem will be solved (NOTE: you should not double click the 
kite.exe to start ACS in KATS directory after you changed the ACS directory name). 

The other error in kits.exe.log as below: 

 Traceback (most recent call last): 

    File "kits.py", line 24, in ? 

    File "hardwareinteg.pyc", line 31, in ? 

    File "ACSLPT.pyc", line 3, in ? 



 Automated Characterization Suite (ACS) Release Notes 
 

PA-1008 Rev. L / November 2017 45 

 

    File "KILPT.pyc", line 12, in ? 

    File "KILPT.pyc", line 10, in __load 

 ImportError: DLL load failed: xxxxxxx 

3. The problem may cause by remove or reinstall GPIB driver.  

Go to C:\WINDOWS\system32\ ieee_32m.dll and delete it. 

Go to C:\WINDOWS\system32\ gpib-32.dll and delete it. 

Reinstall GPIB driver. 

Reinstall ACS. 

4. The problem may cause by install multi GPIB interface or change GPIB interface. 

Remove previous GPIB interface. 

Go to C:\WINDOWS\system32\ ieee_32m.dll and delete it. 

Go to C:\WINDOWS\system32\ gpib-32.dll and delete it. 

Reinstall GPIB driver. 

Reinstall ACS. 

3. Nivisv32.dll error and ACS cannot launch. 

The problem may cause by KTE and NI software installing, the Nivisv32.all and Visa32.dll version does not match. 
The error messengers refer to as below:  

‘The ordinal 126 could not be located in the dynamic library NIVISV32.dll’ 

‘The ordinal 18 could not be located in the dynamic library NIVISV32.dll’ 

Go to C:\WINDOWS\system32\ NiviSv32.dll and rename it. 

Go to C:\WINDOWS\system32\ Visa32.dll and rename it. 

Install ACS. 

Also you can update NI-Visa runtime 4.3 or higher version to solve this problem. 

4. LPTLIB.dll error and ACS cannot launch. 

This problem may be caused by KTE 6.2 or earlier version when installed.  

Update to KTE v8.1 or higher version to fix this issue. 

5. When installing ACS an ibup.dll error may occur. 

This problem may happen when you reinstall ACS. 
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To fix this issue, open the Windows Task Manager, stop the UTMserver, KTMserver, or Kits and reinstall ACS. 

6. ACS will not start due to an invalid password, after updating ACS. 

This issue may happen after updating ACS to ACS v4.3 or higher. 

Go to C:\ACS\KATS\KATS_pref.ini file and rename it to KATS_pref_old.ini. 

Start ACS, login as ACSADMIN and enter the default password. 

7. ACS cannot scan hardware. 

Disconnect and reconnect the GPIB cable and TSP-Link cable and restart ACS. Additionally, you may need to 
power off and power on instruments and then restart ACS. 

Go to C:\WINDOWS\system32\ ieee_32m.dll and rename it ieee_32_old.dll. 

Install ACS. 

8. ACS opens in Demo mode after generating a temporary license file. 

You need to get an official license file or USB key license; the temporary license file has expired you cannot 
continue to use it. 
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ACS Edition Version 4.3.1 

Enhancements 

Added KTEI version check before running BTI modules (KTEI V8.1-SP2 or higher must be in installed). 

Removed the Sorting radio box in the Summary Report panel. 

Adjusted the total allowed plots to no greater than 36 in the wafer level plot and real time plot. 

Added the CV_ACS.lib file to avoid a link error when building a library using the create_DT tool. 

Synchronized the usrlib.mak file version with KTEI so that the file will not be removed when, or if, ACS is 
uninstalled. 

Upgraded the User Accounts dialog box so that special characters cannot be entered. 

Changed the OCR Reading code for a GPIB according to the S400 code which address the reading string issue. 

Added check point in the process of launching KXCI. For example, if the UTMServer has not started, ACS will wait 
until it starts successfully. 

Model 4200 ITM updated so the call DE command will turn off the output. There is a double delay time if you abort 
between the measurement trigger and the first point data return. 

Updated PrbP8.dll for the getProberPostition.c to support both three digit and four digit coordinate values returned 
from the prober. 

Updated the ACS Reference Manual with new Statistics documentation. 

 

ACS Edition Version 4.3 

Overview  

Version 4.3 is a maintenance release of the ACS Edition software. 

NOTE If you have ACS v4.2 or earlier version installed on your PC, and you are updating to the newest version 
of ACS, you will need to perform the following operations first: 

1. Uninstall the previous version of ACS. 

2. Go to the C:\S4200 directory on your computer and rename it C:\S4200_old (NOTE: this only applies if you 
are NOT installing ACS directly on a Model 4200A or 4200). 

3. Remove the C:\ACS\KATS\KATS_pref.ini file. 

4. Install the newest version of ACS. 
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Enhancements 

Disabled points setting in ITM linear sweep X configuration; you can only edit the step value; the points value will be 
calculated automatically according to the step value. For the log sweep X configuration, you can edit the points 
value; the step value cannot be used. 

Supported copy partial data and export all data when right-clicking at data page. 

Adjusted the access in operator mode. 

Added VALIDATE_OCR UAP to correct wafer id before it is written to the .kdf file. 

Added the prb_err_hdlr UAP. If this UAP is added, the test will not stop if a prober error occurs. You will have to 
write a recovery prober error code at this point. 

Added the FUNC_GET_PRB_ERR to obtain the prober error code and prober error message; designed to use in 
prb_err_hdlr UAP. 

Opened formula for end user; the path to the formula is .\library\ExtLibrary. 

The ACS append mode was increased to default at 30.  

Added invalid project name check for Save As and Save As Template dialog. 

Added time register in Exception file. 

The project/file option only lists the available projects for the operator end user. 

Added an option to the Preferences dialog box to select or de-select prober status. 

Built in the latest version of the KXCI client tools. 

End user is not able to override Auto-Test information with the FUNC_SET_GLOBAL_VALUE UAP in 
automation_begin. 

In limit sheet setting, the report flag will affect the data output into KDF file. 

Added the UAP_VALIDATE_OCR to correct wafer id. 

Added the directory location of the .kdf files to the Preferences dialog box. 

Added compliance status checking function in the Python LPT for Series 2600A instruments. 

Added S400 LPTLIB functions that are available on S530 Parametric Test System (for example, searchX) that are 
compatible with the S400 LPTLIB commands. 

Added the S400 and S600 LPTLIB function rtfary to the STM and PTM LPTLIB commands. 

Added python LPTLIB command support for the sweepv and smeasz functions for the Model 4200-CVU. 

In the Script Editor, removed the import library function. You will have to load the library from the library drop-down 
menu. 
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The Script Editor allows a default value for a string input variable. 

Statistics was updated to allow selectable expression formats on a wafer map. 

Statistics was updated for the scale property and now can be saved or loaded. 

Statistics was updated to allow manual scale settings in the Histogram. 

Statistics was updated to allow indication lines on the Histogram and CDF. 

Added a file overwrite confirmation to the ACS Summary Report section. 

Critical fixes 

CVU test and HV Model 2410 are supported in confidence check testing for the S530 System only. 

Added support for both All wafer and Random wafer on P8 prober. 

Statistics added Histogram and CDF comparison. 

Script Editor added LUA compile tool to support the TSP syntax error check feature. 

Made user password encrypted, and added a dialog box for password management. 

Updated the KTMServer.exe file with a pcivpureset function call to fix the BTI abort issue.   

Added select or de-select option on the Preference dialog box to redirect prober status to log Window. 

Updated the diagCVU with new KXCI communication function. 

Diagnostic testing added a retest or continue feature if testing fails. 

ACS now can poll the Prober for if there is a realign error. 

Non-critical fixes 

Interlock check added in 24lpt sweep/bsweep/asweep function after output on and every 0.5s. 

Added the Model 707B/708B Reference manual to the Help drop-down menu. 

Added an ACS Programmer’s Manual that includes ACS Global Variables and Functions under the Help drop-down 
menu. 

Add S530 Documentation (S530 Administrative Guide, S530 Diagnostics Manual) under Help drop-down menu.  

Added project name 'FACTORY_UTP_CHECKOUT' to the ACS project folder. The project will be used by 
manufacturing to perform the final checkout/burn-in of all S530 systems. 

Added a prompt to continue or stop dialog box, if a prober error occurs. 

RPM: After switch to DC mode, call devclr to clear output. 

Updated the installation register key to solve wrong sampling time. 
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Changed the ACS evaluation license period from two days to 30 days. 

Changed the System Information menu to Trouble Shooting. Included a zipped support file that includes all the 
necessary files for troubleshooting. 

Repaired the ACS .csv file output that did not support subsite#x. 

Repaired SMU2 and SMU3 on a single Model 2635A that did not force a bias voltage. 

The ACS Script Editor Save icon is disabled. 

Repaired the ACS GeneralTestLib hung automation if it has sweep with step. 

Repaired the ACS Script Editor to add extraneous end statements to the TSP modules. 

Repaired the ACS GeneralTestLib trigger overrun. 

Repaired the vertical toolbar that was truncated on the test setup panel. 

Repaired the Script Editor error when inputting digits to str type. 

Repaired errors that occur in the Row-Column diagnostic testing. 

Repaired the ACS Map style that did not output a .csv file. 

Repaired the ACS ITM setting that would disengage if the subdevice was greater than 1. 

Repaired the Python LPT commands conpin and addcon that did not work properly for the CVU. 

Changed the corresponding die size x and die size y concurrently if the orientation changes. 

Repaired the ACS Weibull plot x axis if it is incorrect and does not work for the Weibull analysis. 

Repaired the CTM run problem. 

Repaired the RTM JRAMP memory error. 

Enabled the RTM JRAMP frame for PLC input. 

Disabled the RTM JRAMP limiti setting for the pre-current test. 

Repaired the ACS statistics legend overlap on the wafer. 

Repaired the ACS Wafer Level Plot overlay issue. 

The Script Editor was updated to add default imports. 

Known issues 

If you cannot run the CTM after it has been complied by Visual Studio 2008, you will need to upgrade to NI-VISA 
runtime version 4.6. 
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If any of the matrices in the system are set to Remote Sense or the S530 Kelvin mode, all of the Series 2600A and 
Series 2400 instruments in the system will be set to four-wire (4-W) mode when executing a test. Also, the SMU 
Remote Sense option box in the Preference settings Misc tab will be disabled. When all the matrices are set to 
Local Sense, all of the Series 2600A and Series 2400 instruments in the system will be set to two-wire (2-W) mode 
when executing a test. It is highly recommended that all the matrices in the system are in the same mode. 

Support for the confidence check of the Model 707B matrix only in DDC mode. 

If installing the NI GPIB driver NI-488.2 v2.7.3 or above, the NI VISA driver option is not selected as the default. 
You must choose the NI VISA option when installing the NI GPIB driver. If the NI VISA driver is not installed, the 
instruments may not respond when running a PTM. 

ACS only supports CEC488 GPIB drivers 8.2 or above. If older drivers exist, you will need to upgrade. 

The @ symbol is a key character used in ACS. It should not be used in ACS_PostData, including 
ACSPostDataFloat, ACSPostDataDouble, ACSPostArrayInt, and ACSPostArrayFloat, etc.  

Based on license mode of the USB key inserted, you can access the different modes available in ACS (for 
example, Standard, WLR, and RF)  

While importing the Model 4200 project files, if the subsite does not have any libraries and modules described then 
importing the .kpr (Keithley Project File) will fail (you will receive an error). In addition, the devices imported will 
appear incorrectly.  

By default, the beeper is disabled when executing a module. If you want to disable/enable the beeper when running 
a module, refer to the following steps:  

1. Open the file ACS_setting.ini (in the KATS folder in the ACS file directory).  

2. Find “enable” that is under the item "beeper", beeper->enable.  

3. Set the value to 1 to enable the beeper; set the value to 0 to disable the beeper.  

4. Save the file and the configuration is effective immediately  

Within the BTI Project, and its corresponding modules, the maximum segment number per channel is 2048.  

If you receive a .dll conflict error during ACS installation, shutdown the UTMServer or the KTMServer. If they exist 
in the task manager, then click Retry to continue the installation.  

If you uninstall or reinstall KITE or GPIB drivers after ACS has been installed, ACS may not function due to .dll 
errors. To resolve this issue, you will need to reinstall ACS.  

If you uninstall the NI driver and software, you must reinstall ACS.  

The diagnostic row-column mode has a conflict with the Model 7072HV card because the card contains isolated 
rows (A-B and C-H). They cannot be connected together.  

If you want to use the Model 4200-ITM or Model 4200- CVU, the version of KXCI must be v8.1 or newer.  

On the Model 4200-SCS instrument, if you run a PTM immediately after running an ITM for the Model 4200-SCS, 
you will need to add the statement Get4200HWCtrl() to get control of statements in the module. The GetHWCtrl() is 
in the ACS_PostData module.  
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On the Model 4200-SCS instrument, if you stop a test and the LED stays on, you will need to close ACS and reset 
the hardware (in CMD line, run resethw) for the Model 4200-SCS, then restart ACS.  

On the Model 4200-SCS instrument, if you do not want KXCI to start when you open and run ACS, you can change 
the setting in the .ini file to avoid unnecessary hardware conflicts. You must set the start_kxci value to 0 in the 
ACS_setting.ini file to stop KXCI from running. For example, if you run CTM automation and stop the test 
before it’s finished, you may need to restart ACS because of a hardware usage conflict between CTM and KXCI.  

ACS does not support a remote connection, such as a terminal server, VNC, Windows XP remote client, etc. with 
the USB license key. If you have a requirement to use a remote connection, contact Keithley Instruments, Inc.  

In a parallel RTM test, at least one subdevice with a SMU as the master node has to be selected.  

Since the release of ACS version 4.0, ACS will dynamically load the system script for UAP when running RTM 
projects. If you have an older version of ACS and installed a newer version, you will need to delete preload all, 
delete all and collectgarbage UAPs before running the previous version RTM projects.  

In the Device settings, every Pad Name subdevice must have the correct format (refer to the ACS Reference 
manual for more details).  

For a real-time plot and data display, if the volume of data is large, it may take several seconds for the data to 
update, or may cause the software to stop functioning. For example, if the real-time timer interval is set to update 
every 1 or 2 seconds, it may cause the software to not function properly. You can change the timer interval, if 
needed, in the ACS_setting.ini file.  

ACS does not support mixing Series 2600A instruments with Series 2600 instruments with the DTNS operation 
which includes RTM parallel modules.  

When ACS is installed on the Model 4200-SCS and KITE is upgraded to v8.1, you must delete the ieee_32m.dll file 
in the following location: C:\windows\system32. Once deleted, you must reinstall the CEC488 GPIB driver v8.2.  

If you ever encounter an error, go to the Help drop-down in ACS and select Trouble Shooting, then click Zip 
Support Info. The Zip file will be saved to the following location: ACS\KATS\support_info. Next, send the information 
file by e-mail to the following address: info@keithley.com  

ACS only supports the English language. Errors may occur when saving and opening ACS files if characters from 
other languages are within the names of directories on the computer. 
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ACS Edition Version 4.2.5 

Critical fixes 

Supports S530 full-Kelvin configuration. 

Repaired BTI real-time data back issue using banding sequences. 

Repaired limitation issue in GUI list in BTI. 

Repaired pre-test and post-test inter-stress exception issue in BTI. 

Repaired double pattern created in S900 conversion. 

Repaired import WDF problem. 

ACS build incorporated latest KTEI version, upgraded to Visual Studio 2010, cleaned up unneeded files. 

Repaired prb_error (UAP was not working). 

Non-critical fixes 

Removed the password display in user account dialog box. 

Added dialog box for password management (will not show content of any password). 

Improved operator security. 

 

ACS Edition Version 4.2 

Overview  

Version 4.2 is a maintenance release of the ACS Edition software. 

Enhancements 

ACS installation enhancement, minimize overwrite of KITE files and synchronize prober drivers with KITE. 

S530 enhancements include confidence check, diagnostic, CVU and calibration/verification. 

ACS performance optimization includes start/load project, start automation and data handling. 

Added debug tools capability for Python modules. 

Hardware configuration updated for scanning Model 3401/3402. 
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Critical fixes 

Diagnostic support for the S530HV Kelvin mode. 

Confidence check support for the S530HV Kelvin mode. 

Added Python LPT for the Series 2600A and 2400 instruments: bsweepi, bsweepv, trigcomp, trigig, trigil, trigvg, 
trigvl. 

Non-critical fixes 

Updated ACS to support Windows® XP multiple users; added Initialize User in Start > Programs > ACS 4.2. First, 
you will need to create a new user account that has rights to the registry table. Then you will need to click the menu 
in the new user account and restart your PC. ACS will then work for multiple logins to the Windows XP 
environment. 

Made a S530 enhancement for CVU, added CpGp through the switch compensation example project. You can find 
it in the following folder location: ACS\projects\CVU_CpGp_Compensation. 

Disabled Preferences settings for the operator mode. 

Incorporated an automatic copy function, while ACS is installing, for the KXCI patch and old KILPT.dll files, if KITE 
version is older than 7.0. 

Added a CSV file saving function for multiple groups in RTM test. 

Graphically defined a new device update by adding a pad setting dialog using the matrix mode. 

Repaired the global variables ACS_ssite_loopNum and ACS_ssite_loop. 

Added support for exporting and importing a test tree pattern at the sub site or device level in Map mode project. 

Added a default path for importing and exporting project tests in Tools > Preferences > Path tab 
(C:\ACS\Projects). 

Updated the automation options: there are three options in automation; Skip 1st Wafer Load, Single Wafer, and 
Unload Wafer after test. The options have been updated in order to save in individual projects after you change an 
option, and each project has all of these options. 

Updated the use of the USB license key so that it can be used for ACS standard and ACS Basic on the same PC. 

Added LPT support for the Model 3401/3402 (34xxlpt). 

Repaired the RTM renaming issue. 

Repaired the KITE issue of entering Demo mode unless ACS has launched first. 

Repaired the missing PTM GUI after importing and switching back to the hardware configuration view. 

Added a save new project path for the S900 converter. 

Repaired the issue of not being able to find 42SMUs in the ITM after setting the IP address in the Model 4200 
settings. 
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Repaired the importing S4200 project issue that resulted in an incorrect device type. 

Repaired the issue of ACS freezing when clicking on a sub site and new type of project. 

Added a new formula to the formulator: GET_LISTINDEX. 

Added an exit button to the PTM Script Editor. 

Repaired the formulator SS function. 

Added a pop-up window message to let you know that KITE is launching. 

Repaired the standard CSV file output. 

Repaired the colors in the Wafer Level Plot since they did not match the binning settings when all the sites were 
selected on a wafer. 

Added support to the PTM, STM, and ITM for the set mode setting measure.delay. 

Improved the scanning in Model 2420 in ACS hardware configuration. 

Made ACS login username and password case sensitive. 

Repaired the .kdf file data that is not complete in automation with CTM (online mode). 

Improved the module MDD.py in order to control the matrix open or close. 

Removed the calibration and verification functions from the preload functions and added a LoadFunc.stm to the 
calibration and verification project. 

Repaired Script Editor so that library names can start with the letter “t.” 

Added support for Pattern ID so that you can log information in the log window with LogInfo. 

Updated the FS NBTI and add limit to prevent multiple sweeps. 

Updated the FS NBTI GUI checks when no terminal is selected for measurement. 

Repaired the FS NBTI so that parallel mode can be selected for the RTM. 

Repaired the FS NBTI so that the Apply to All function works correctly. 

Improved ACS v4.1 .wdf file to increase the speed of loading. 

Provided an up and down option for node in the test tree. 

Added the default to disable beep when executing a module. 

Repaired the deleted module in Script Editor so that it is refreshed in the test setup. 

Improved start ACS after set pseudo card of Model 3706. 

Improved the ability to show the whole test name in the basic monitor items in automation. 
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Added capability for ACS to automatically scale graphs on the graph sheet. 

Improved the axis settings so that the minimum and maximum entry is loaded with the Auto Scale Values. 

Improved the converting a S900/S400/S600 CPF so continue process, if error occurs. 

Improved the addcon command with the Model 3706 and instruments connected to rows and pins to column. 

Repaired the CVU so that it cannot be connected by the switch control LPT. 

Improved ITM to reduce errors when conducting many samples in a test or using Ethernet communications. 

Changed the settings so that you cannot change some default values in the automation settings in order to prevent 
unnecessary errors in your tests. 

 

Known issues 
 

Using KITE software 
version 7.0 with Model 
4200-SCS ITMs 

If you install KITE software version 7.0 and want to use a Model 4200-SCS interactive 
test module (ITM), make sure you have the newest version of the kxci_patch files in 
your S4200 folders. Compare the dates of the kxci_patch files located in the 
ACS\KATS folder with kxci_patch files in the following folders: 

• S4200\sys\bin 

• S4200\sys\include 

• S4200\sys\lib 

If any of the files in the S4200 folders are older than the file in the ACS\KATS folder, 
replace them with the newer file. 

Running a PTM after 
an ITM on a Model 
4200-SCS 

To run a Python programming language test module (PTM) after running an 
ITM on a Model 4200-SCS, you must add the Get4200HWCtrl() statement to 
the ACS_PostData module (before any statements in the PTM) to get control 
of the hardware. 

English language 
requirement in project 
folders 

ACS software only supports the English language. You may receive errors in 
your tests if you save files in other languages in the same folders where your 
ACS project files are kept. 

If you have questions or need further assistance, contact Keithley Instruments at 1-888-KEITHLEY (534-8453) 
(U.S. only) or send email to info@keithley.com. 
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